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1. Getting started 
 

The Dashboard is a community project and it not affiliated in any way with Stein Investments – the 

authors of the tools used by the dashboard. The authors of the dashboard make no representation as to 

the quality, fitness for purpose nor validity of the logic or signals generated by the Dashboard. Use at 

your own risk. 

 

This is an indicator – not an EA. It does not open trades for you – (though you can use its signals to send to 

an EA.). If you choose to trade from the Dashboard signals… 

1. Trading forex entails risk which may exceed your account balance. No representation is made as 

to the accuracy of the signals presented by the dashboard.  

2. If you choose to use the dashboard it is at your own risk.  

3. It is highly recommended that you use a demo account. 

4. The dashboard is a community developed project and will likely contain bugs which may result in 

incorrect signal. If you use the Dashboard, you accept that incorrect signals may be generated 

and any trades made using these signals are your accountability.  

5. Please report bugs - See reporting a suspected bug section below. 

 

• The dashboard was designed to run on MT4 - there is also a port of the dashboard to MT5 

• It requires the Stein Investment tools as detailed here :  

 STS 2020 - a major update for our Simple Trading System- 

https://www.mql5.com/en/blogs/post/738876  

• The dashboard requires at a minimum FX Power to operate. However, it is designed to be used with FX 

Power, FX Trend, Lighthouse and optionally FX Volume.  

• You must install the STS FX tools onto MT4 prior to using the dashboard. 

 

 

We strongly recommend that you study the STS System and Stein Tools 

and operate these manually before using the Dashboard. This will help 

you become familiar with the way the Dashboard operates and how to set 

it up. 

 

 

   

 

 

https://www.mql5.com/en/blogs/post/738876
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2. Installing the Dash 
 

This is an indicator – not an EA.  It goes in the Indicators folder. 

1. In MT4, Open your "Application Data" folder. 

First you need to locate your Application Data folder of the MT4. To do this, go 

to the File menu in the MT4 platform and click on "Open Data Folder" (check 

out the image below) 

 

2. Put the file “STS-Dashboard-v1.0.ex4” into the Indicators folder. 

3. Refresh the list of indicators and you will see the Dashboard in the list of Indicators 

 
 

4. After installing the Dashboard indicator, in the MT4 terminal, you need to enable DLL 

 
5. You must install the STS FX tools onto MT4 prior to using the dashboard. 

The dashboard requires at a minimum FX Power to operate. However, it is designed to be used 

with FX Power, FX Trend, Lighthouse and optionally FX Volume.  
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3. Loading the Dash 
1. Open a blank chart and load the Dashboard indicator onto the chart. 

2. Ensure the Allow DLL Imports is clicked 

 
3. You should not have any other indicators on the chart 

 

4. The dashboard should appear within one or two seconds on the chart. If it does not, then there are 

issues - check the “Experts” tab for error messages 

5. The dashboard runs against all 28 pairs and makes a lot of calls to the indicators so you may 

experience issues if you are running it on a system that has low resources or compute power or lots 

of other open charts. Having said that, I run it on a 2 core, 4GB VPS with two instances of MT4 each 

with 10 to 20 open charts with multiple EA’s indicators with no issues. 

6. It is recommended that you run the dashboard on its own chart with no other indicators or EA’s 

loaded on that chart. Other indicators may interfere with the operation of the dashboard.  

7. You do not need to separately load any of the FX tools onto the chart - the dashboard will call them 

from the code. 
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4. Interface Features 
 

 

 

 
1. Mini-Mode.   Clicking this will shrink the panel as shown below, making it easier to see the rest of the 

chart.  

 
2. Click on the symbol in the list to change to this symbol chart. There are options in the settings to 

change what happens when you click the symbol button. You can do nothing, change this chart symbol, 

open a new chart with the selected symbol, or change another chart’s symbol (with the use of a helper 

indicator “changesymbol-slave” attached to that chart).  

 

The symbol will highlight to show if there is a signal. By default, the row will also be highlighted, e.g. 

the following image shows a BUY for AUDCAD. 
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3.  The “Clock” column shows the time in minutes since the signal has been activated.  Clicking 

this button paints historical trade lines on the screen. It causes the indicator to go back a user-specified 

number of bars (default is 500) and check each bar against the settings to identify if a signal would 

have triggered on that bar. It then draws lines (“history lines”) on the chart so that the user can see 

where signals would have been generated based upon the rules as specified in the indicator. 

4. These are the triggers and are highlighted or greyed out to indicate if they are on or off, respectively.  

When the dash is opened, they are set as per the settings. However, you can turn them on and off by 

clicking this interface, i.e. to turn off delta simply click the delta button.   

When a trigger is disabled it will continue to show the triggers in the column. However, they will be 

dimmed to show they are inactive. 

5. This is the custom indicator column. It is hidden by default as it is still experimental and under 

development. It enables you to call a user-specified indicator and use those values as a trigger/filter. 

6. The notes column is hidden by default. If notes are activated in the settings, clicking this button will 

hide or show the notes.  

7. Like the STS tools panels, you can double-click on the background of the dashboard and a white border 

will highlight around the borders of the dashboard. You can then click and drag the dashboard to 

another location on the chart. Double clicking again on the dashboard background sets the new 

location of the dashboard. You can also set the starting X and Y coordinates in the settings. 
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5. Dashboard Settings 
You can edit the Dashboard settings by right clicking anywhere on the chart and 

selecting Indicators -> STS-Dashboard-v1.0 -> Edit 

 

 

------------------------------------>>> Currency Pairs to display <<<----------------------------------------- 
Blank=ALL, CSV list (AUDUSD,GBPUSD), "."=Chart pair 

By default the dashboard will load all 28 symbols. You can specify a list of specific symbols that you 

would like loaded here. You do not need to enter the symbol suffix since this will be identified 

automatically. If you enter a single character (for example a “.”) then the Dash will use the current 

chart symbol only.  

---------------------------------------->>> Signal Triggers <<<----------------------------------------------- 

 

Here you set up the triggers and filters used to generate a Buy or Sell signal on the dashboard. These 

correspond to the headings on the columns on the dashboard. When set to true, they will show as 

highlighted-heading columns on the dashboard. When set to false, they will be greyed out on the 

dashboard and will not be used as triggers or filters for the signal. 

Some of these indicators are triggers and some are filters – e.g. ADR is more of a filter than a trigger. It 

should be noted that cross triggers operate independently from the other STS triggers, as Cross is not 

strictly part of the STS system.    

Use Trend as Trigger (Rule 1) (default=True) 

If true, Signals will only be given in the direction of trend.  

By default this does not apply to cross signals: cross signals, by default, operate independently of trend 

direction although you can change this in the options. See “Cross Logic ignores Trend and uses cross 

direction instead (default=True)” below. 

Use FX Power Threshold as Trigger Base (Rule 2) (default=True) 
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Fx Power for Base on all three timeframes must exceed the specified threshold level in order to 

generate a trigger. For example: FX Power of Base currency must be greater than 8 on all three 

specified timeframes OR FX Power of Base currency must be less than 1 on all three specified 

timeframes. 

Use FX Power Threshold as Trigger Quote (Rule 2) (default=True) 

Fx Power for Quote on all three timeframes must exceed the specified threshold level in order to 

generate a trigger. For example: FX Power of Quote currency must be greater than 8 on all three 

specified timeframes OR FX Power of Quote currency must be less than 1 on all three specified 

timeframes. 

Use FX Power Delta Threshold as Trigger (Rule 3) (default=True) 

Delta is the difference between base and quote Fx Power on each timeframe. By default, Fx Delta 

needs to exceed 3 on each timeframe to ensure that there is sufficient separation between the power 

of the base and quote currencies. 

Use Lighthouse as trigger (Rule 4) (default=True) 

This setting will prevent signals from being generated when the price is close to support and resistance 

levels. 

Use Volume as Trigger (Rule 5) (default=True) 

Fx Volume needs to be within the set criteria in order to enable a signal to be generated. Fx Volume 

operates in a similar manner to Fx Power to provide a broker’s perspective on the current long volume 

of open positions for each of the base currencies. In principle, if the base volume is increasing and the 

quote volume is decreasing, this supports a Buy position and vice versa. 

 

The following settings are not part of the STS system. 

Use Cross as Trigger (INDEPENDENT of Rules 2&3 !!!) (default=True) 

Cross signals are generated independently of the STS system. For example: a buy cross signal is where 

the base Fx Power on all three timeframes moves above the quote power, and vice versa. 

Use ADR as Trigger (default=False ) 

ADR is more of a filter than a trigger. It is useful to avoid signals if the price is ranging (ADR % too low), 

or if the price has moved too much (ADR % too high). 

Use Custom Indicator as Trigger (default=False) 

This is an experimental feature which enables you to connect to an external indicator and include this 

as part of the dashboard. Due to constraints within the way MT4 terminals operate there are 

limitations on passing parameters to indicators. This feature is still in development. 

Show Notes Fields (default=False) 

This displays an editable field on the chart where you can enter your notes around trading specific 

currency pairs. These notes are saved to a file and will reload if you close and reopen your MT4 

terminal. 
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--------------------------------------->>> Signal SetUp <<<-------------------------------------------------- 
 

Use previous Bar for triggers (except Light House/Volume) (default=True) 

To avoid false signals, by default the dashboard uses the previous closed bar for all its information, 

except for Lighthouse and Fx Volume.  

Supress SIGNALS that are same as last signal (default=False) 

If set to true, this parameter will enforce alternating signals, i.e. if a buy signal is generated, the 

dashboard will only show the next sell signal (ignoring further buy signals), and vice versa. So your 

signals will always be like this: BUY -> SELL -> BUY -> SELL, etc. This applies to all signals, including cross 

signals. 

Supress CROSS TRIGGERS that are same as last (default=False) 

If set to true, this parameter will enforce alternating CROSS signals i.e. if a buy CROSS signal is 

generated, the dashboard will only show the next sell CROSS signal (ignoring further buy signals), and 

vice versa. So your CROSS signals will always be like this BUY -> SELL -> BUY -> SELL, etc. 

-------------------------------------->>> FX Trend Setup <<<--------------------------------------------------- 
See this link for details of FX Trend: https://www.mql5.com/en/market/product/14852#!tab=overview 

Trend Timeframes in CSV list (i.e. M30,H1,H4,D1) (default= "M5,M15,M30,H1,H4,D1") 

The FX Trend timeframes that will be used to generate a trigger. All timeframes must align, i.e. they 

must all be BUY or all be SELL. Take note that by default the dashboard uses the previous closed bar for 

the trend. As a result the trend may be different from what you are seeing on the screen currently with 

Fx Trend. The values are entered as a comma separated list. Please take care not to leave spaces in 

between your entries and do not use anything other than valid MT4 timeframes and a comma. 

Trend intensity (Optional: use CSV list one per TF) (default=80) 

This is the trend intensity from Fx trend. The trend intensity from Fx Trend must be above this value on 

all trend timeframes in order to generate a signal. It is used in combination with the FX Trend direction 

to generate the dashboard buy/sell. By default, the same value will be applied to each of your trend 

timeframes i.e. 80 intensity threshold will be applied to M5, M15, M30, H1, etc. 

Optionally you can enter a comma-separated list specifying a separate trend intensity for each of the 

timeframes. E.g. if you have “M30,H1,H4,D1” for your timeframes, you could either enter insert 80 as 

the intensity and it will be used as the threshold for all these timeframes, or you could specify the  

different intensities in the order of the timeframes, i.e. “30,50,70,80” would mean a requirement of 

M30>30,H1>50,H4>80,D1>80 intensity to trigger. 

The dashboard does not use “stars” but for reference, the FX Trend rating and interpretation of 

intensity is as follows: 

Rating Value Interpretation Get in Get out 

1 star <20 critical trend No Yes 

2 stars >20 weak trend No Yes 

3 stars >40 neutral trend stay stay 

https://www.mql5.com/en/market/product/14852#!tab=overview
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Rating Value Interpretation Get in Get out 

4 stars >60 healthy trend Yes No 

5 stars >80 strong trend Yes No 

 

FX Trend Periods (default=6) 

Number of periods to calculate the trend of all timeframes 

FX Trend Deviation (default=3) 

Value to calculate the trendline: smaller = tighter / higher = wider 

---------------------------------------->>> FX Power Setup <<<------------------------------------------------ 
Here you specify the Fx Power settings for the three Fx Power timeframes. If you want to use less than 

three timeframes you can simply set the other timeframes to the same timeframe, i.e. make them all 

“1 Day”. 

Fx Power is the core of the system. You can read more about Fx Power at: 

https://www.mql5.com/en/blogs/post/738876 

In this section we set the parameters that will be used to trigger the Base, Quote and Delta triggers. 

Note that Cross does not use the thresholds or Delta specified here. 

How to choose the right FX Power timeframe? 

The FX Power timeframe is completely independent of any chart time frame. If you choose 1 Day, FX 

Power considers the entire historical data of the past 24 hours beginning from this second to 

determine the currency strength. If you choose 1 week, FX Power considers the entire historical data of 

the past 5 trading days beginning from this second to determine the currency strength. 

Example: If you trade the D1 chart time frame we recommend using an FX Power timeframe of 1 or 2 

weeks. 1 week is a bit faster, 2 weeks is a bit smoother. In the end, it is up to you which analysis period 

suits your trading style best. 

FX Power Timeframe 1 (default=1 Day) 

FX Power TF1 must be higher than this(-1) (default=8) 

FX Power TF1 must be lower than this (10) (default=1) 

FX Power TF1 Delta Must be above this level (default=3) 

FX Power Timeframe 2 (default=3 Days) 

FX Power TF2 must be higher than this(-1) (default=8) 

FX Power TF2 must be lower than this (10) (default=1) 

FX Power TF2 Delta Must be above this level (default=3) 

FX Power Timeframe 3 (default=1 Week) 

FX Power TF3 must be higher than this(-1) (default=8) 

FX Power TF3 must be lower than this (10) (default=1) 

https://www.mql5.com/en/blogs/post/738876
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FX Power TF3 Delta Must be above this level (default=3) 

FX Power Threshold Type Above/Below or In Range (default= FX Power Above/Below Thresholds 

(Normal)) 

In default mode, ie. with FX Power Threshold Type Above/Below or In Range = FX Power Above/Below 

Thresholds (Normal)), to generate a trigger for Base currency, the Fx Power level for Base must be ALL 

higher (Buy) or ALL lower (Sell) on ALL 3 timeframes, as shown by the arrows below. 

To generate a trigger for Quote currency, the Fx Power level for Quote must be ALL higher (Sell) or ALL 

lower (Buy) on ALL 3 timeframes, as shown by the arrows below. 

 

 

 

There is also the option to set FX Power Threshold Type Above/Below or In Range= FX Power BETWEEN 

thresholds. In this mode, the thresholds operate as a band – all FX Powers must be within this band to 

trigger. In this mode the trigger does not have a direction and appears as a white square on the Dash 

rather than red or green. 

 

FX Power Values Must Be Increasing/Decreasing (default=False) 

By default, this is off/false and the slope of the Fx Power lines are ignored. If set to true, then the slope 

of the Fx Power for each currency is checked to confirm its alignment with the rest of the Fx Power 

triggers. For example, if this is set to true, Base FX Power must be rising (lines going up) on all 3 

timeframes for the last 3 bars for a BUY to be valid. 

FX Power All Base>Quote(Buy)/Base<Quote (Sell) (default=False) 

By Default, this if Off/False and the position of the base and quote FX Power values relative to each 

other is ignored. 
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If set to true, all Base FX Power values for the last 3 bars on all timeframes must be above/below all 

Quote a FX Power trigger to be valid and vice versa. For example: 

 

    

 

---------------------------------------->>> LightHouse SetUp <<<---------------------------------------------- 
Standard lighthouse settings – see more details at: https://www.mql5.com/en/market/product/3941  

LightHouse SR Distance in Pips (default=5) 

LightHouse Timeframe (default=0) 

----------------------------------------->>> Volume SetUp <<<--------------------------------------------- 
The following volume setting should be read in consideration with how to trade with Fx Volume. See 

specific suggestions from Daniel Stein at: https://www.mql5.com/en/blogs/post/733987  

Display Volume column (if false also disables trigger) (default=True) 

Broker DST zone (default= NO_DST_ZONE) 

Standard volume settings. See more details at: https://www.mql5.com/en/market/product/14987#  

Broker GMT shift (default=0) 

Standard volume settings. See more details at: https://www.mql5.com/en/market/product/14987#  

Compare with X hours back (default=24) 

Standard volume settings. See more details at: https://www.mql5.com/en/market/product/14987# 

Use Thresholds for FX Volume (default=False) 

If enabled, the following two settings apply (FX Volume of RISING Currency must be higher than this 

(default=50) & FX Volume of FALLING Currency must be lower than this (default=50). 

FX Volume of RISING Currency must be higher than this (default=50) 

The Fx Volume of the rising currency, i.e. the currency in the Fx Volume window that is increasing in 

volume, must be above this threshold. The idea is that you want the increasing currency to be above a 

certain level before it is considered a significantly powerful move. 

FX Volume of FALLING Currency must be lower than this (default=50) 

https://www.mql5.com/en/market/product/3941
https://www.mql5.com/en/blogs/post/733987
https://www.mql5.com/en/market/product/14987
https://www.mql5.com/en/market/product/14987
https://www.mql5.com/en/market/product/14987
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The Fx Volume of the falling currency, i.e. the currency in the Fx Volume window that is decreasing in 

volume, must be above this threshold. The idea is that you want the decreasing currency to be below a 

certain level before it is considered a significantly powerful move. 

Use previous Bar for Volume (shift (default=False) 

By default, we use the current reading for Fx Volume as it moves very slowly and is not prone to 

whippy movements. 

Just use two points for volume check (Bar0/Bar2) (default=True) 

Fx Volume moves very slowly, and on occasion you might get a situation where there is a clear uptrend 

but the last three readings are for example 48, 47, 52. In this case, if set to false, as all three values are 

not increasing, the code would ignore this. By default, just use two points for volume check is set to 

true, so it will check 48 and 52 and use those as the decision that volume is in an uptrend.  

Bars offset to use for slope check (Bar1) (default=2) 

Usually you would check the previous sequential bars (ie. Shift 0, 1 and 2) when looking for an up or 

downtrend slope. However, because Fx Volume moves very slowly, we set an offset for this first bar. 

This offset is added to the bars back in an effort to more accurately identify the slope.  

In this case 2 (by default) is added to the previous bar equating to a shift of 3 bars back from current 

open bar). 

Bars offset to use for slope check (Bar2) (default=5) 

Usually you would check the previous sequential bars (ie. Shift 0, 1 and 2) when looking for an up or 

downtrend slope. However, because Fx Volume moves very slowly, we set an offset for the second bar. 

This offset is added to the bars back in an effort to more accurately identify the slope.  

In this case 5 (by default) is added to the shift=2 equating to a shift of 7 bars back from current open 

bar). 

FX Volume Delta must be decreasing/Increasing... (default=True) 

The difference between the two Fx Volume lines is increasing or decreasing. 

 

FX Volume Base>Quote(Buy)/Base<Quote (Sell) (default=False) 

Require the Fx Volume of the base currency to be currently above the Quote currency in order for a 

Buy signal to be generated (vice versa for a sell signal). This option is false by default as in the above 

diagram. 

If set to true, it prevents triggering for the following situation where Base (blue) is clearly getting 

stronger and Quote (red) is clearly getting weaker BUT Base is not yet above quote. So this setting 

would prevent a trigger. 
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Minimum delta (default=2) 

Minimum number of percentage points between the two Fx volume lines.  

-------------------------------------->>> ADR Trigger Setup <<<---------------------------------------------- 
ADR represents the average daily range of the price over the last X periods (default five days).   

If set to active, the price must be within the specified ADR% range (average daily range). The current 

daily price range is represented as a percentage of this average daily range and gives an indication of 

how far the price has moved today versus the average of the last five days price movement. This gives 

an indication if price has moved too far, or if price is stagnated.  

The colour of the ADR value indicates whether the price is currently above (green) or below (red) the 

day’s opening price. The ADR value will turn white if the current ADR is outside the specified thresholds 

(and the user has selected to filter on ADR). When white (i.e. outside thresholds), then signals will not 

be generated. 

E.g. in the below image, NZDUSD has moved 244% of the normal daily range – perhaps not a good time 

to enter a trade. 

 

ADR % must be BELOW this level (default=160) 

ADR % must be ABOVE this level (default=0) 

ADR Period (Days) (default=5) 

-------------------------------------->>> Cross Detection Setup <<<----------------------------------------- 
Cross detection is not part of the  STS strategy. It is however described under the Fx Power indicator at: 

https://www.mql5.com/en/market/product/15422#!tab=overview  

Crosses are a powerful indicator of a change in direction of a currency pair. Detecting a meaningful and 

valid cross however can be difficult and so a number of algorithms have been included in the 

dashboard to provide the user with choice of the mechanism used to identify a cross. 

 

Which Cross Logic to use (default=”1: Current Bar cross & Prev 2 not (Few false Pos)”) 

The available cross detection methods are: 

  1: Current Bar cross & Prev 2 not (Few false Pos) 

Checks if all the Fx power lines for Base currency are higher or lower than all FX Power lines for Quote 

currency, and if this was not the case for the previous two bars i.e. there was not a valid cross that 

https://www.mql5.com/en/market/product/15422#!tab=overview
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occurred in the previous two bars. 

 

 

 

  2: Current Bar cross & Prev  not (More false Pos) 

Methos 2 is the same logic as method 1, but only looks back one bar. 

 

  3: Lagging + Threshold (No false positives) 

Method 3 is a lagging method, giving the alarm after the crossing happened a couple of bars ago. It 

means that: 

• it needs a confirmation going up and going down; 

• it happens on the 3rd bar; 

•  the green lines below are the range where you want the indicator to check for crosses, and the 

strength is the amount of crossings. 
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Method 1&2: Delta must be above this (default=0) 

FX Power Delta (the difference between the Fx Power values of base and quote currencies) on all Fx 

Power timeframes in the current bar (right?) must be greater than this value. The aim is to avoid weak 

crosses.  

The following settings only apply if the user selects Cross Logic method 3, “3: Lagging + Threshold (No 

false positives)” 

Method 3: Cross Upper Threshold (default=8) 

Method 3: Cross Lower Threshold (default=0) 

Method 3: Cross Strength (default=2) 

Method 3: Cross Distance (default=0.2) 

Cross Logic ignores Trend and uses cross direction instead (default=True) 

Crosses are often counter or early in a trend and as such cross signals rarely line up with FX Trend. Buy 

and sell signals are by default driven by the direction of the cross not by the direction of the current Fx 

trend. This is the preferred and recommended method. However, if you want to include trend as part 

of the filters for crosses then set this to false: in this case the cross direction must align with the Fx 

trend direction.  

------------------------------------->>> Custom Indicator Setup <<<---------------------------------------- 
This is an experimental setting that enables the user to specify his own indicator as part of the 

dashboard. The example given here is for the RSI (relative strength indicator). 

Display Custom Indi Dash (if false also disables trigger) (default= false) 



 pg. 18 

MT4 name of custom indicator (default=RSI) 

Displayed Name on Dashboard (default=RSI) 

Indicator time frame (default=60) 

Indicator parameters (CSV) 

This setting is not currently working. You can only use default values when calling indicators 

Trigger Type (BUY) (default=3) 

Indicator Value ABOVE Bid Price 

Indicator Value BELOW Bid Price 

Indicator Value ABOVE User Set Value 

Indicator Value EQUALS User Set Value 

Indicator Value BELOW User Set Value 

Display value only - Not used as Trigger! 

Indicator Buffer to read for a BUY signal (default=0) 

Indicator returned Value Trigger BUY (default=70) 

Trigger Type (SELL) (default=5) 

Indicator Value ABOVE Bid Price 

Indicator Value BELOW Bid Price 

Indicator Value ABOVE User Set Value 

Indicator Value EQUALS User Set Value 

Indicator Value BELOW User Set Value 

Display value only - Not used as Trigger! 

Indicator Buffer to read for a SELL signal (default=0) 

Indicator returned Value Trigger SELL (default=30) 

Refresh custom indicator ever x Seconds (default=60) 

Leave as False - this is a "special" use case of CI calling CI (default=False) 

Make signal latching - will stay on until next signal (default=False) 

-------------------------------------->>> Alert Setup <<<------------------------------------------------- 
Minutes Between Repeat Alerts for same signal (default=240) 

Sometimes a signal can go on and off on the dashboard, e.g.  when the price is hovering around a 

support and resistance level. This may generate multiple signals. The delay is introduced to prevent 

multiple alerts for signals in the same direction for the same currency. 

Popup Alerts (default= false) 

Send email (default= false) 

To receive email messages, you have to configure the MT4 terminal properly. The configuration must 

be done in: MT4 Menu -> Tools -> Options -> Email. 
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Send push notification (default= false) 

To receive Mobile Push notifications, you have to enable Push Notifications and to enter your mobile 

terminal MetaQuotes ID at: MT4 Menu -> Tools -> Options -> Notifications. 

Only allow alerts between these hours (default= false) 

Alert Start Hour (default=11) 

Alert End Hour (default=21) 

User Text to add to Alert 

A unique text here to enable users to run multiple dashboards with different strategies and identify 

which alert is from which dashboard. 

------------------------------------->>> EAX Setup:<<<------------------------------------------------ 
Dashboard EAX is an EA used to execute and manage trades. It is highly customisable. Dashboard 

signals can be sent to EAX to create an automated trading platform. See for more details: 

https://www.forexfactory.com/thread/568595-dashboard-eax 

 

 
 

Use PINS to trade via Dashboard EAX (default=False) 

Send signals to dashboard EAX. The signals are sent via global variables. 

Supress EAX Signals on Startup/Settings change (default=True) 

When the dashboard starts there may be signals immediately generated. Setting this to true 

suppresses the initial signals that would have been sent to EAX when the dashboard is initially started. 

Future signals generated will be sent to EAX. 

EAX signal pin (default=1) 

“PIN” number to be used as trade entry on the EAX 

------------------------------------->>> Display Setup:<<<------------------------------------------------ 
Action when clicking currency in list (default= Change this chart) 

• Do Nothing 

• Change this chart: change this chart symbol 

https://www.forexfactory.com/thread/568595-dashboard-eax
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• Open New Chart: open a new chart with the selected symbol 

• Change Slave: change another chart’s symbol with the use of a helper indicator 

“changesymbol-slave” attached to that chart 

When to refresh the dash (default=1 Second) 

The dashboard makes many calls to the indicators to get the information required for all of the pairs 

displayed on the screen. If these calls are too frequent than that can cause problems with the values 

returned by the indicators (insufficient time is available between each of the calls for the indicators to 

respond correctly). This can lead to incorrect results being displayed on the dashboard. Leaving this at 

the default setting of one second producers a reasonable compromise in the frequency of data updates 

on the dashboard. 

• 1 Second 

• 10 Seconds 

• 30 Seconds 

• 1 Minute 

• New Bar 

upColor (default=LawnGreen) 

Colour used for a buy signal 

downColor (default=Crimson) 

colour used through a sell signal 

flatColor (default=clrSnow) 

colour used through nondirectional signal 

textColor (default=clrLightGray) 

colour of text displayed in the headings 

fontSize (default=9) 

Font size of text displayed on the screen.  

Note that this is also used to scale the dashboard. Increasing the size of the font will proportionally 

increase the size of the dashboard. If you change this setting you will also need to adjust the following 

settings: Column spacing, Row spacing, Scaling factor for Width of the buttons, Scaling factor for Height 

of the buttons. 

fontNameHeading (default=Arial) 

fontNameBody (default=Arial) 

headingSelectedColor (default=clrLightGoldenrod) 

headingNotAButton (default=clrSnow) 

headingUnSelectedColor (default= C'25,25,25') 

headingSelectedTxtColor (default=clrBlack) 

headingUnSelectedTxtColor (default= clrGray) 

signalActiveButtonBGColor (default= C'25,25,25') 
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Display Background (default=True) 

Background Color (default= C'25,25,25') 

Dash starting position on screen X (default=0) 

Dash starting position on screen Y (default=15) 

Column spacing (default=43) 

Row spacing (default=19) 

Scaling factor for Width of the buttons (default=4.5) 

Scaling factor for Height of the buttons (default=2) 

Start in Mini-Mode (default=False) 

----------------------------->>> Logging & Historical Signal Display <<<----------------------------------- 
Possibly one of the most useful features of the dashboard is to draw lines on the chart where signals 

would have been generated, which is a sort of mini-visual backtest. 

This feature is activated by either setting the below “Display historical signal lines” to true or clicking 

the clock symbol on the dash. It will produce lines on the current chart (and arrows if selected) for the 

nominated number of bars (500 by default). It should be noted that these lines are not 100% accurate 

as they do not consider tick data. However, they are generally fairly accurate and give you a strong 

sense of how well your settings will perform and makes tuning of the settings significantly easier. The 

lines are updated if you click on Volume, Cross or Delta on the dashboard headings, for example. 

The two types of signals are represented by different style lines, e.g. dashes for cross signals and dots 

for STS signals. 

In addition to drawing the historical lines, future signals will also place a line (or an arrow, if set) on the 

chart. 

 

 

  

Highlight an active signal row (default=True) 
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Draws a red or green highlight on the dashboard when there is an active signal.  

Display historical signal lines (default=False) 

As explained above this draws lines on the chart to illustrate where signals would have been generated. 

Signal Line Type (default=Dots) 

The type of line that will be drawn on the chart to symbolise an STS signal.  

Signal Line width (default=1) 

Signal Line Type (Cross) (default=Dash) 

The type of line that will be drawn on the chart to symbolise a cross signal 

Signal Line width (Cross) (default=1) 

Show Triggers data on screen with the lines (default=False) 

Shows text on the screen with the trigger settings at the time that the signal was generated. Mainly for 

debugging purposes so you can tell what set of triggers generated the signal line. 

Draw Arrows (default=False) 

Draws an arrow on the chart at the point of the signal. Some people prefer arrows, I prefer lines as 

they are easier to align with the Fx Power and Fx Volume so that you can examine the Fx Power and Fx 

Volume values to determine the validity of the signal. 

Arrow Size (default=2) 

Display data for bars that did not signal (default=False) 

When used with “show triggers data on screen with lines” (above), this setting will display the trigger 

data at each of the bars regardless of whether a signal was generated on that bar or not. This is very 

useful for debugging to understand what prevented the signal from being generated at that bar, for 

example if you set a Delta threshold and this was not met.  

Letters are used to represent each of the trigger types: T for trend. B for Base, etc. 

How many history bars to display signals for (default=500) 

How many bars to go back when drawing the lines. Consideration should be given for how much 

history data you have available in MT4 (for all timeframes specified in Fx Trend). For example, if you 

are on an hourly chart and have specified to use M5 in Fx Trend, then to display the Fx Trend 500 H1 

bars ago, that equals 500×1 hour which in five minute bars is 6,000 bars of M5 history.  

So you need to have at least 6000 M5 bars available in your history. If this is set to more than the 

history bars available, the indicator will only display back to the available history for the lowest 

timeframe.  

Log real time signals for all pairs to a file (default=False) 

If activated, all signals generated will be logged to a file along with the raw indicator values to aid in 

debugging. The file will be placed in the directory “MQL4\Files\STS” and be given a name as follows 

filename="STS"+"__"+YMDHMS(GetWinLocalDateTime()); 

ie. C:\Program Files (x86)\MetaTrader\MQL4\Files\STS\STS___2020-9-15___17-57-52.csv 
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folderName  (default=STS)  

Foldername used to store the log file 

 

------------------------------------>>> Dev Stuff Ignore Below <<<-------------------------------------- 
STSDebugMode (default=False) 

Enables printing of debug information on the screen. 

Use a line like the following in the code: 

        DebugMessage("deltaVolume0:"+deltaVolume0, 13); 

this will then display the text at line 13 on the screen. 

 

Display raw values in a table to aid debugging (default=False) 

 

useGrowl (default= false) 

This is used by the creator of program to call a Windows batch file to send messages via growl instant 

messaging.  I don’t expect that anybody else will be using it, however for completeness this is what is in 

the bat file 
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echo off 

set arg1=%1 

C:\"Program Files (x86)\Growl for Windows\growlnotify" /t:"TRADE ALERT" /p:2 /a:"STS" /r:"STS 

Notification" /n:"STS Notification" /silent:true %arg1% 


